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Questo documento viene fornito ai clienti che hanno acquistato apparecchiature SCIEX come guida
all'utilizzo e al funzionamento delle stesse. Questo documento è protetto da copyright e qualsiasi
riproduzione, parziale o totale, dei suoi contenuti è severamente vietata, a meno che SCIEX non abbia
autorizzato per iscritto diversamente.

Il software menzionato in questo documento viene fornito con un contratto di licenza. La copia, le
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indicazione contenuta nel contratto di licenza. Inoltre, il contratto di licenza può vietare che il software
venga disassemblato, sottoposto a reverse engineering o decompilato per qualsiasi scopo. Le garanzie
sono indicate in questo documento.

Alcune parti di questo documento possono far riferimento a produttori terzi e/o a loro prodotti, che
possono contenere parti i cui nomi siano registrati come marchi e/o utilizzati come marchi dei rispettivi
proprietari. Tali riferimenti mirano unicamente a designare i prodotti di terzi forniti da SCIEX e incorporati
nelle sue apparecchiature e non implicano alcun diritto e/o licenza circa l'utilizzo o il permesso concesso
a terzi di utilizzare i nomi di tali produttori e/o dei loro prodotti come marchi.

Le garanzie di SCIEX sono limitate alle garanzie esplicite fornite al momento della vendita o della licenza
dei propri prodotti e costituiscono le uniche ed esclusive dichiarazioni, garanzie e obbligazioni di SCIEX.
SCIEX non rilascia altre garanzie di nessun tipo, né espresse né implicite, comprese, a titolo di esempio,
garanzie di commerciabilità o di idoneità per un particolare scopo, derivanti da leggi o altri atti normativi
o dovute a pratiche e usi commerciali, tutte espressamente escluse, né si assume alcuna responsabilità
o passività potenziale, compresi danni indiretti o conseguenti, per qualsiasi utilizzo da parte dell'acquirente
o per eventuali circostanze avverse conseguenti.

Solo per scopi di ricerca. Non usare in procedure diagnostiche.
I marchi e/o i marchi registrati menzionati nel presente documento, inclusi i loghi associati, sono di
proprietà di AB Sciex Pte. Ltd., o dei rispettivi proprietari, negli Stati Uniti e/o in altri Paesi (vedere:
sciex.com/trademarks).

AB SCIEX™ è utilizzato su licenza.
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Questa guida fornisce le informazioni e le procedure sull'installazione del PA 800 Plus
EmpowerTM Driver. Il PA 800 Plus EmpowerTM Driver consente di eseguire l'acquisizione dati
da un sistema PA 800 Plus Pharmaceutical Analysis utilizzando il software Waters EmpowerTM

3 (FR4). Il PA 800 Plus EmpowerTM Driver deve essere installato sullo stesso computer del
software Waters EmpowerTM.
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Requisiti del sistema operativo
Questa versione del software è compatibile con Microsoft Windows 10 a 64 bit. Per i requisiti
del computer, fare riferimento alla sezione: Requisiti del computer.

Requisiti del computer
Il computer deve soddisfare i requisiti minimi per Microsoft Windows 10, software a 64 bit. Per
ulteriori dettagli, fare riferimento alla documentazione fornita da Waters.

È necessaria anche una porta USB libera.

Configurazione del controller convalidata
Tabella 2-1 Configurazione del controller convalidata

DettagliElemento

Microsoft Windows 10 Enterprise 2016 LTSBSistema operativo

• Client Oracle versione 12.1.0.2.0 per sistemi a 32 bit

• Software Waters EmpowerTM

• Driver National Instruments, versione 19

Software aggiuntivo

Minimo: CPU per Windows 7 o 10 Intel 2 Duo, E6400
2,13 GHz

Consigliata: Intel Core 2 Duo, E8400 3,0 GHz

CPU

Minima: 4 GB
Consigliata: 8 GB

RAM (Random Access
Memory)

Minimo: 25 GBDisco rigido

2 GB per il software Waters EmpowerTMSpazio libero su disco

Minimo: risoluzione 1024 × 768 (ad eccezione dei moduli
LAC/E)

Consigliata: risoluzione 1920 × 1080 per il client

Monitor
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Tabella 2-1 Configurazione del controller convalidata (continua)

DettagliElemento

Hub seriale a 8 porteInterfacce di controllo
opzionali

1 scheda Ethernet per la connettività di rete
Minimo: più di 100 Mbps
Consigliato: 1 Gbps

Schede Ethernet

Software necessario
È necessario installare il software Waters EmpowerTM 3. Il PA 800 Plus EmpowerTM Driver è
stato convalidato con il software Waters EmpowerTM 3 (FR4).

Durante la valutazione del cliente per l'accesso anticipato, i clienti hanno valutato il PA 800
Plus EmpowerTM Driver e lo hanno ritenuto compatibile con il software EmpowerTM 3 (FR2) o
versioni successive.

Per funzioni di elaborazione dati aggiuntive:

• Per eseguire calcoli di analisi qualitativa per le applicazioni SDS-MW e cIEF, il software
Waters EmpowerTM GPC è necessario.

• Per eseguire calcoli di farmacopea standard come la risoluzione o il rumore e la deriva, il
software Waters EmpowerTM System Suitability è necessario.

Contattare un rappresentante di vendita Waters per acquistare una licenza per uno o l'altro
software.

Versione del firmware di PA 800 Plus necessaria
Il PA 800 Plus EmpowerTM Driver è stato convalidato sui sistemi con le seguenti versioni del
firmware PA 800 Plus. Fare riferimento a Tabella 2-2.

Tabella 2-2 Versioni del firmware PA 800 Plus convalidate

Versione del firmwareSistema PA 800 Plus

10.2.3Sistema PA 800 Plus privo di certificazione
ROHS

10.2.5-RSistema PA 800 Plus con certificazione ROHS

10.3.7-RSistema CESI 8000 Plus

Se il firmware PA 800 Plus non è una delle versioni convalidate, deve essere aggiornato per
assicurarsi che il PA 800 Plus EmpowerTM Driver sia compatibile con il software Waters
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EmpowerTM e gli strumenti SCIEX utilizzati per eseguire una qualificazione operativa. Fare
riferimento a Determinare la versione del firmware utilizzando il software Waters EmpowerTM.

Determinare la versione del firmware del sistema PA 800 Plus
Determinare la versione del firmware utilizzando il software Waters EmpowerTM

1. Aprire il software Waters EmpowerTM e fare clic su Run Samples.
2. Selezionare il sistema corretto e fare clic su OK.
3. Fare clic su View > System.

Figura 2-1 Finestra di dialogo System Information

4. Fare clic su Scan Instruments.
Se la colonna OK? contiene Sì, il driver comunica con il modulo LAC/E.

5. Scorrere a destra della colonna Details.
La versione del firmware viene mostrata con altri dettagli del sistema.

Figura 2-2 Versione del firmware
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Se è necessario aggiornare il firmware, contattare un rappresentante di vendita SCIEX.

Determinare la versione del firmware utilizzando il software 32 Karat

1. Aprire il software 32 Karat.

2. Selezionare lo strumento corretto per effettuare l'accesso.

Nota: Assicurarsi che il sistema PA 800 Plus e il controller comunichino.

Figura 2-3 Finestra del software 32 Karat

3. Fare clic su Control > Instrument Status > View.
4. Scorrere verso il basso per trovare la versione del firmware.

Note di rilascioPA 800 Plus EmpowerTM Driver
RUO-IDV-03-9720-IT-B8 / 41

Requisiti



Figura 2-4 Versione del firmware

Se è necessario aggiornare il firmware, contattare un rappresentante di vendita SCIEX.
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Controllo dei driver installati in precedenza
1. Controllare se il diver Beckman Coulter PACE MDQ Control for Waters Empower è

installato.

a. Fare clic su Control Panel > Programs and Features.
b. Cercare il software Beckman Coulter PACE MDQ Control for Waters Empower.

Se è presente, disinstallarlo. Fare riferimento a Disinstallazione del driver Beckman
Coulter PACE MDQ Control for Waters Empower Software.

2. Determinare se è installata la versione corretta del driver del software National
Instruments.

Nota: Il PA 800 Plus EmpowerTMDriver richiede il driver National Instruments Software
versione 19.0. Se è installata un'altra versione, è necessario rimuoverla.

a. Fare clic su Control Panel > Programs and Features.
b. Cercare National Instruments Software.

Se il numero di versione non è 19.0 (o non viene visualizzato alcun numero di
versione), disinstallarlo. Fare riferimento a Disinstallazione delle versioni precedenti
del driver del software National Instruments.

Disinstallazione del driver Beckman Coulter
PACE MDQ Control for Waters Empower
Software
1. Chiudere qualsiasi programma software Waters EmpowerTM aperto.

2. Fare clic su Control Panel > Programs and Features.
3. Fare clic su Beckman Coulter PACE MDQ Control for Waters Empower software,

quindi su Uninstall/Change.
Viene visualizzata la InstallShield Wizard.

4. Fare clic su Remove, quindi su Next.
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Figura 3-1 Procedura guidata Beckman Coulter PACE MDQ Control for Waters
Empower InstallShield

5. Nel messaggio visualizzato, fare clic su Yes per rimuovere tutte le funzioni.
6. Quando viene eseguita la disinstallazione, fare clic su Finish per chiudere la finestra

InstallShield Wizard.

7. Nel pannello di controllo Program and Features, fare clic con il pulsante destro del
mouse, selezionare Refresh, quindi assicurarsi che Beckman Coulter PACE MDQ
Control for Waters Empower software non sia più presente.
Se il driver è ancora visualizzato nel pannello di controllo, ripetere la procedura per
disinstallarlo.

Disinstallazione delle versioni precedenti del
driver del software National Instruments
Nota: Il PA 800 Plus EmpowerTM Driver richiede il driver National Instruments Software
versione 19.0. Se è installata un'altra versione, è necessario rimuoverla.
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1. Fare clic su Control Panel > Programs and Features.
2. Fare clic su National Instruments Software, quindi su Uninstall/Change.

Viene visualizzata lafinestra di dialogo di disinstallazione del software National
Instruments.

3. A seconda della versione del driver installato, effettuare una delle seguenti operazioni:

• Tenere premuti i tasti Ctrl-Maiusc, premere la freccia giù per selezionare tutte le
voci dell'elenco, quindi fare clic su Remove.

Figura 3-2 Finestra di dialogo di disinstallazione del software National
Instruments

• Fare clic su Remove All.

Figura 3-3 Finestra di dialogo di disinstallazione del software National
Instruments

4. Al termine della disinstallazione, fare clic su Yes per riavviare il computer.
5. Dopo il riavvio del computer, eseguire l'accesso.
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Installazione del PA 800 Plus EmpowerTM Driver
Nota: Il PA 800 Plus EmpowerTM Driver deve essere installato sul server Citrix, se il PA 800
Plus EmpowerTM Driver viene eseguito nell'ambiente Citrix.

1. Inserire il DVD del PA 800 Plus EmpowerTM Driver nell'unità DVD.

2. Accedere alla cartella PA 800 Plus Empower Driver V1.3.0, quindi fare doppio clic su
setup.exe.
Viene visualizzata la finestra di dialogo Open File - Security Warning.

3. Fare clic su Run.
Viene aperta l'installazione guidata PA 800 Plus EmpowerTMDriver InstallShield Wizard.

Figura 3-4 Installazione guidata del Sciex PA 800 Plus EmpowerTM Driver
InstallShield Wizard

4. Nella pagina License Agreement fare clic su I accept the terms of the license
agreement, quindi su Next.

5. Per installare il software, seguire le istruzioni visualizzate. Quando richiesto, accettare
I valori predefiniti. Se all'inizio dell'installazione vengono visualizzate delle avvertenze,
ignorarle.

PA 800 Plus EmpowerTM DriverNote di rilascio
13 / 41RUO-IDV-03-9720-IT-B

Istruzioni di installazione



Installazione del National Instruments Software
Driver
Il PA 800 Plus EmpowerTM Driver richiede National Instruments Software Driver versione 19.0.

1. Sul DVD di installazione del PA 800 Plus EmpowerTM Driver, accedere alla cartella
NI-488.2 19.0 Driver e fare doppio clic su Install.exe.
Viene visualizzata la finestra di dialogo Open File - Security Warning.

2. Fare clic su Run.
Il programma di installazione verifica la presenza di contratti di licenza e apre la pagina
seguente.

Figura 3-5 Installazione guidata NI Package Manager

3. Fare clic su I accept the above 2 license agreements., quindi suNext finché non viene
visualizzata la pagina NI Package Manager.

4. Nell'elenco Additional items you may wish to install fare clic su NI-488.2 .NET
Language Runtime 17.0.1 for .NET Framework 4.5, quindi su Next.
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ATTENZIONE: Possibile errore di comunicazione. Assicurarsi che sia selezionato
il componente NI-488.2 .NET Language Runtime 17.0.1 for .NET Framework 4.5
prima di fare clic su OK. Se il componente non è installato, il modulo LAC/E e il
sistema PA 800 Plus non saranno in grado di comunicare.

Nota: per impostazione predefinita, in questo elenco sono selezionati altri componenti.
Sono anch'essi necessari, pertanto devono rimanere selezionati.

Figura 3-6 Componenti .NET richiesti

5. Nella pagina Agree fare clic su I accept the above 2 license agreements., quindi su
Next.

6. Nella pagina successiva, fare clic su I accept the above 2 license agreements., quindi
su Next.
L'installazione può richiedere alcuni minuti.
Al termine dell'installazione, viene visualizzato un messaggio relativo al servizio di
aggiornamento NI.
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Figura 3-7 Messaggio NI Update Service

7. Fare clic su No.
8. Se il programma di installazione visualizza un messaggio relativo al programma per

migliorare l'esperienza d'uso di NI, fare clic su No, I do not want to participate in the
NI Customer Experience Improvement Program, quindi su OK.

9. Fare clic su Reboot Now per riavviare il computer.

10. Accedere al computer.

Nota: se viene visualizzata una finestra di dialogo che richiede la registrazione del
software, fare clic su Cancel per chiuderla.
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Utilizzare le seguenti procedure per configurare il software Waters EmpowerTM per poterlo
utilizzare con il sistema PA 800 Plus

Modifica delle unità di pressione
Il software Waters EmpowerTM è in grado di visualizzare la pressione in psi o millibar. Per
impostazione predefinita, l'unità di misura della pressione è il millibar. Le unità di misura della
pressione possono essere modificate dalla workstation LAC/E workstation o dal server Citrix.

Utilizzare le seguenti procedure per modificare le unità.

1. Accedere al computer come utente con privilegi di amministratore.

2. Chiudere il software Waters EmpowerTM.

3. Aprire la finestra Registry Editor.

a. Fare clic su Start, digitare R, quindi fare clic su Run.
Viene visualizzata la finestra di dialogo Run.

b. Digitare regedit.
c. Fare clic su Yes nel messaggio che viene visualizzato.
Viene visualizzata la finestra Registry Editor.

4. Individuare la voce di registro per le unità di pressione.

a. Fare clic su Edit > Find.
b. (Opzionale) Fare clic sulla cartellaHK_LOCAL_MACHINE nella struttura ad albero.

Suggerimento! La ricerca della voce è molto più veloce quando si seleziona
HK_LOCAL_MACHINE.
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c. Nel campo Find what: digitare PressureUnitPSI e fare clic su Find Next.

Figura 4-1 Finestra di dialogo Find

La ricerca può richiedere un po' di tempo. Quando viene trovata la chiave, viene
evidenziata nel riquadro destro della finestra Registry Editor.

Figura 4-2 Registry Editor.

5. Modificare la voce di registro.
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a. Fare doppio clic su PressureUnitPSI.
Viene visualizzata la finestra di dialogo Edit DWORD (32-bit) Value.

Figura 4-3 Finestra di dialogo Edit DWORD (32-bit) Value

b. Nel campo Value data, digitare il valore delle unità, quindi fare clic su OK.
• 1 per psi
• 0 per mbar

c. Fare clic su File > Exit per salvare le modifiche e chiudere la finestra Registry Editor.

Configurazione del server di acquisizione
Nota: Impostare il server di acquisizione nel software Waters EmpowerTM 3 (FR4) prima di
completare la seguente procedura. Per le istruzioni, fare riferimento alla documentazione del
produttore fornita con il software.

1. Fare doppio clic sull'icona Empower sul desktop ed eseguire l'accesso come utente
con privilegi di amministratore.

2. Nella finestra di dialogoWaters EmpowerTM software Start fare doppio clic suConfigure
the System.
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Figura 4-4 Finestra di dialogo Waters EmpowerTM Software Start

Viene visualizzata la finestra Configuration Manager.

Nota: L'elenco dei nodi nella figura seguente rifletterà la configurazione del software
Waters EmpowerTM.
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Figura 4-5 Finestra Confguration Manager

3. Nella tabella, fare clic con il pulsante destro del mouse sul nodo da configurare e
selezionare Properties.
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Figura 4-6 Finestra di dialogo Node Properties, scheda General

4. Fare clic sulla scheda Configure DHCP, quindi fare clic su Configure DHCP.
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Figura 4-7 Scheda Configure DHCP

Viene visualizzata la finestra di dialogo Waters DHCP Server Configuration.

PA 800 Plus EmpowerTM DriverNote di rilascio
23 / 41RUO-IDV-03-9720-IT-B

Configurazione del software Waters EmpowerTM



Figura 4-8 Finestra di dialogo Waters DHCP Server Configuration

5. Se in precedenza è stato installato il driver Beckman Coulter PACE MDQ Control per il
software Waters Empower, eliminare eventuali strumenti CE esistenti nell'elenco. Fare
clic su BCPACEMDQ nella finestra di dialogo, quindi fare clic su Remove.

6. Fare clic su Add.
Viene visualizzata la finestra di dialogo Add IP Address.

7. Aggiornare i campi nella finestra di dialogo come indicato di seguito.

Figura 4-9 Finestra di dialogo Add IP Address

a. Lasciare vuoto il campo IP Address. Non è necessario per un sistema PA 800 Plus.
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b. Lasciare vuoto il campo MAC Address. Non è necessario e viene impostato
automaticamente su 00-00-00-00-00-00.

c. Fare clic su Instrument Type e selezionare PA800PLUS dall'elenco.

d. Nel campo Serial Number/Unique Name, digitare 1.
e. Fare clic su OK.
Se viene visualizzato un messaggio relativo all'indirizzo MAC, chiudere il messaggio,
digitare un numero qualsiasi nel campo MAC Address, quindi fare clic su OK.

8. Se il driver Beckman Coulter PACE MDQ Control per il software Waters Empower è
stato installato in precedenza, fare clic sulla scheda Instruments.

Figura 4-10 Scheda Instruments

9. Eliminare tutti gli strumenti precedentemente configurati associati al driver Beckman
Coulter PACE MDQ Control per il software Waters Empower.

PA 800 Plus EmpowerTM DriverNote di rilascio
25 / 41RUO-IDV-03-9720-IT-B

Configurazione del software Waters EmpowerTM



a. Fare clic sulla riga con lo strumento da eliminare, quindi fare clic su Remove
Instrument.
Per gli strumenti configurati in precedenza è presente l'indicazione BCPACEMDQ
nella colonna Type.

Figura 4-11 Messaggio di conferma

b. Fare clic su Yes nel messaggio visualizzato, quindi fare clic su Yes nel messaggio
che segue.

c. Se nella colonna Type sono presenti altri strumenti con BCPACEMDQ, ripetere la
procedura per eliminarli.

10. Fare clic su OK.
Viene chiusa la finestra di dialogo Node Properties.

11. Se è necessario connettere un secondo PA 800 Plus al modulo LAC/E, ripetere questa
procedura nel passaggio 7, digitare 2 nel campo Serial Number/Unique Name.

Nota: I passaggi aggiuntivi necessari per impostare il secondo sistema PA 800 Plus
devono essere eseguiti da un FSE SCIEX. Contattare l'assistenza tecnica SCIEX sul
sito sciex.com/request-support.
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Impostazione di un nuovo sistema
cromatografico
Il software Waters EmpowerTM è stato progettato per la cromatografia. Pertanto qualsiasi
strumento collegato al software è detto "sistema cromatografico". Prima di poter essere utilizzato,
il sistema PA 800 Plus deve essere configurato come sistema cromatografico.

1. Nella finestra Configuration Manager fare clic su File > New > Chromatographic
System.

Viene visualizzata la New Chromatographic System Wizard.

Figura 4-12 Pagina Type Entry

2. Fare clic su Create New System, quindi su Next.

Nota: L'elenco dei nodi nella figura seguente rifletterà la configurazione del software
Waters EmpowerTM.
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Figura 4-13 Pagina Select Server

3. Fare clic sul nodo con il sistema PA 800 Plus e fare clic su Next.
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Figura 4-14 Pagina System Selection

4. Nell'elenco Available Instruments visualizzato a sinistra, fare clic su PA800PLUS#1,
trascinare la voce nell'elenco New System Instruments a destra, quindi fare clic su
Next.

5. Aggiornare i campi della pagina come indicato di seguito.
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Figura 4-15 Pagina Access Control

a. Share System with Other Network Users: selezionare l'opzione per consentire ad
altri utenti nella rete di accedere al sistema.

b. Allowed Access: selezionare l'opzione per definire i tipi di utenti autorizzati ad
accedere al sistema. Le scelte sono Owner Only, Owner and Group(s) o Owner,
Group, andWorld. Per le ultime due, selezionare i gruppi nell'elencoAllow Access
to Group(s).

c. Allow Access to Group(s): selezionare l'opzione per definire i gruppi a cui è
consentito l'accesso al sistema.

È necessario selezionare almeno un gruppo.

d. Password Protect SystemAccess: selezionarePasswordRequired per richiedere
una password. Nei campi Password e Confirm Password, digitare la password,
con una lunghezza massima di 30 caratteri.

e. Fare clic su Next.
6. Aggiornare i campi della pagina come indicato di seguito.
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Figura 4-16 Pagina Name Selection nella New Chromatography System Wizard

a. System Name: digitare il nome del sistema, fino a un massimo di 30 caratteri. Il
nome viene utilizzato nel database Empower e nella finestra Configuration Manager.

b. Online: selezionare questa casella di controllo per portare il nuovo sistema online.
c. System Comment: (opzionale) digitare commenti o altre informazioni di

identificazione del sistema, fino a un massimo di 250 caratteri.

d. Fare clic su Finish.
e. Se viene visualizzato un messaggio relativo a un sistema esistente configurato in

un altro sistema online, fare clic su OK.

Definizione dei vassoi tamponi e campioni
Nel software Waters EmpowerTM, i vassoi campione e buffer nel sistema PA 800 Plus sono
definiti come "piastre". Le piastre devono essere definite nel software Waters EmpowerTM. Per
semplificare questo processo, SCIEX fornisce i file di testo con le informazioni necessarie che
possono essere importate.

1. Inserire il DVD del PA 800 Plus EmpowerTM Driver nell'unità DVD.

2. Nella finestra dialogo Start del software Waters EmpowerTM, fare clic su Configure the
System.
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Viene visualizzata la finestra Configuration Manager.

3. Fare clic su Plate Types per mostrare le piastre già definite.

Figura 4-17 Tipi di piastra nella finestra Configuration Manager

4. Creare la piastra per il vassoio tamponi.

a. Fare clic con il pulsante destro del mouse nella tabella, quindi selezionare Import
from Text.

b. Fare clic su Browse e navigare sul file PA800Plus Buffer Tray.txt nel DVD del PA
800 Plus EmpowerTM Driver.

Nota: se il DVD non è disponibile, nel presente documento è inclusa una copia
del file. Copiare il contenuto e incollarlo in un file di testo. Fare riferimento a File
di definizione delle piastre.

c. Ditiare PA 800 Plus Buffer Tray nel campo New Plate Type Name e fare clic su
OK.
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Figura 4-18 Finestra di dialogo Import Plate Type From Text File

Il vassoio buffer viene aggiunto all'elenco nella finestra Configuration Manager .

5. Ripetere il passaggio 4 per creare i vassoi campioni.

• Per il vassoio campione a 48 fiale, selezionare il file PA800Plus Sample Tray.txt e
nominare la piastra PA 800 Plus Sample Tray.

• Per il vassoio campione a 96 fiale, selezionare il file PA800Plus 96 Well Sample
Tray.txt e nominare la piastra PA 800 Plus 96 Well Sample Tray.

Come per il vassoio tamponi, se il file di definizione della piastra non è disponibile, in
questo documento è disponibile una copia. Fare riferimento aFile di definizione delle
piastre.

Nota: Il file di definizione della piastra per la piastra campioni a 96 pozzetti è quello
per la piastra SCIEX a 96 pozzetti standard (PN 609844). Per utilizzare una piastra a
96 pozzetti di un altro produttore, fare clic su File > New > Plate Type nella finestra
Configuration Manager, quindi definire la piastra manualmente.

6. Se il driver Beckman Coulter PACE MDQ Control per il software Waters EmpowerTM è
stato installato in precedenza, eliminare eventuali piastre create per l'utilizzo con il driver.
Fare clic con il pulsante destro del mouse sul numero di riga della piastra, quindi
selezionare Delete.

7. (Opzionale) Per visualizzare le informazioni dettagliate di una piastra, fare clic con il
pulsante destro del mouse sul numero di riga della piastra, quindi selezionare Properties.

8. (Opzionale) Per eliminare una piastra, fare clic con il pulsante destro del mouse sul
numero di riga della piastra e selezionare Delete.
È possibile eliminare solo le piastre aggiunte da un utente. Le piastre predefinite non
possono essere eliminate.
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9. Fare clic su File > Exit per chiudere la finestra di dialogo Configuration Manager.
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• Se il cavo di interfaccia GPIB viene rimosso dal modulo LAC/E, la comunicazione al sistema
PA 800 Plus andrà persa. Collegare il cavo di interfaccia GPIB e riavviare il modulo LAC/E.

• In un metodo set campioni, tutti i valori nel campo Injection Volume vengono ignorati. Il
software Waters EmpowerTM usa invece il parametro Duration per l'evento di iniezione per
determinare il volume di iniezione.

• In un Inject Pressure Capillary Fill, si verifica un errore se sample lid viene selezionato
per le posizioni del vassoio. Selezionare invece Sample come posizione del vassoio e
impostare l'incremento della fiala su 1.

Nota: L'utente deve programmare un metodo specifico se è necessario tornare a una fiala.

PA 800 Plus EmpowerTM DriverNote di rilascio
35 / 41RUO-IDV-03-9720-IT-B

5
Problemi noti del PA 800 Plus
EmpowerTM Driver



Questa sezione include le definizioni delle piastre per il vassoio tamponi, il vassoio campioni
e il vassoio campioni a 96 pozzetti SCIEX. Queste piastre devono essere definite nel software
Waters EmpowerTM.

I file devono essere installati durante l'installazione del PA 800 Plus EmpowerTM Driver.

Se mancano ed è necessario definire le piastre, copiare il testo, incollarlo in un editor di testo
e salvare il file.
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File di definizione piastre vassoi buffer
PA800Plus
Empower Profile for Plate Type: CE Buffer Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 85.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 9.00
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 6
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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File di definizione piastre vassoi campioni
PA800Plus
Empower Profile for Plate Type: CE Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 17.10
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 8
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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File di definizione piastre vassoi campioni a 96
pozzetti PA800Plus
Empower Profile for Plate Type: 96-Well Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 11.00
  Top Left Well Y Location: 14.50
  Well Diameter: 6.80
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 12
  Row Spacing: 9.00 mm
  Number of Columns: 8
  Column Spacing: 9.00 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On

PA 800 Plus EmpowerTM DriverNote di rilascio
39 / 41RUO-IDV-03-9720-IT-B

File di definizione delle piastre



Formazione dei clienti
• In Nord America: NA.CustomerTraining@sciex.com

• In Europa: Europe.CustomerTraining@sciex.com

• Al di fuori dell'Unione Europea e del Nord America, visitare sciex.com/education per trovare
le informazioni di contatto.

Centro di istruzione online
• SCIEX Now Learning Hub

Acquisto di materiali di consumo
È possibile riordinare i materiali di consumo SCIEX online all'indirizzo store.sciex.com. Per
impostare un ordine, utilizzare il numero di account presente nel preventivo, nella conferma di
ordine o nei documenti di spedizione. Lo store online SCIEX è attualmente limitato agli Stati
Uniti, al Regno Unito e alla Germania, ma in futuro sarà esteso ad altri paesi. I clienti di altri
paesi possono contattare il rappresentante locale SCIEX.

Assistenza SCIEX
SCIEX e i suoi rappresentanti si affidano a uno staff di tecnici di manutenzione e assistenza
formati e qualificati, presenti in tutto il mondo. Saranno felici di rispondere a domande sul
sistema o su eventuali problemi tecnici che potrebbero sorgere. Per ulteriori informazioni,
visitare il sito web SCIEX all'indirizzo sciex.com oppure è possibile contattarci in uno dei seguenti
modi:

• sciex.com/contact-us

• sciex.com/request-support

Sicurezza informatica
Per le ultime indicazioni sulla sicurezza informatica per i prodotti SCIEX, visitare il sito
sciex.com/productsecurity.
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Documentazione
Questa versione sostituisce tutte le versioni precedenti del documento.

Per visualizzare il documento in formato elettronico, è necessario che sia installato Adobe
Acrobat Reader. Per scaricare la versione più recente, visitare il sito Web
https://get.adobe.com/reader.

Per reperire la documentazione del software del prodotto, fare riferimento alle note sulla versione
o alla guida all'installazione del software fornita con il software.

Per reperire la documentazione del prodotto hardware, fare riferimento al DVD Customer
Reference fornito con il sistema o il componente.

Le versioni più recenti della documentazione sono disponibili sul sito Web SCIEX, all'indirizzo
sciex.com/customer-documents.

Nota: per richiedere una versione stampata gratuita del presente documento, contattare
sciex.com/contact-us.
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